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SAR TEST REPORT 
Report Number: M121125R2_FCC_MC8355_SAR_GSM-UMTS 

WWAN FCC ID: EJE-MC8355D  IC: 337J-MC8355D 
 

1.0 GENERAL INFORMATION 
Table 1 

Test Sample:  Fujitsu Stylistic Q series Tablet PC 
Radio Module Under Test: MC8355 
Interface Type: Mini-PCI Module 
Device Category:  Portable Transmitter 
Test Device: Pre-Production Unit 
Host PC model: Q572 
WWAN FCC ID: 
WWAN IC: 

EJE-MC8355D 
337J-MC8355D 

RF exposure Category:  General Population/Uncontrolled 
  
Manufacturer: Fujitsu Limited 
  
Test Standard/s: 1. Evaluating Compliance with FCC Guidelines For Human Exposure to 

Radiofrequency Electromagnetic Fields 
  Supplement C (Edition 01-01) to OET Bulletin 65 (Edition 97-01) 
 2. Radio Frequency Exposure Compliance of Radiocommunication 

Apparatus (All Frequency Bands) 
  RSS-102 
 3. EN 62209-2:2010 

Human exposure to radio frequency fields from hand-held and body-
mounted wireless communication devices. Human models, 
instrumentation, and procedures.    
Part 2: Procedure to determine the specific absorption rate (SAR) for 
wireless communication devices used in close proximity to the human 
body (frequency range of 30 MHz to 6 GHz) 

 4. IEEE 1528: 2003 
Recommended Practice for Determining the Peak Spatial-Average Specific 
Absorption Rate (SAR) in the Human Head Due to Wireless Communications 
Devices: Measurement Techniques.

  
Statement Of Compliance: The Fujitsu Tablet Computer Q572 with Sierra Wireless 

GSM/UMTS/EVDO Module MC8355 complied with the FCC General 
public/uncontrolled RF exposure limits of 1.6mW/g per requirements 
of 47CFR2.1093(d). It also complied with IC RSS-102 requirements. 

  
Test Dates: 4th November to 10th November 2012 
  
 
Test Officer: 

 Peter Jakubiec
  
  
Authorised Signature: 

 Chris Zombolas 
Technical Director 
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SAR TEST REPORT 
Portable Tablet Computer 

Model: Q572 
Report Number: M121125R2_FCC_MC8355_SAR_GSM-UMTS 

 
2.0 INTRODUCTION 

 
Testing was performed on the Fujitsu Tablet PC, Model: Q572 with SIERRA Mini-PCI Wireless WAN Module 
(Gobi 3000), Model: MC8355, with Ralink USB Wireless LAN Module (802.11a/b/g/n), and Broadcom Bluetooth 
Module, Model: BCM92070MD_REF6.  Bluetooth Transmitter nominal power is less than 5mW.  The Gobi 3000 
module is an OEM product.  The Mini-PCI Wireless WAN (WWAN) was tested in the dedicated host – 
STYLISTIC Q series, Model Q572. The system tested will be referred to as the DUT throughout this report. 

 
2.1 Product Features 
 

a. G- Sensor is implemented to enable power reduction based upon tilting angle of slate 
PC and viewing positions. 

b. Overall dimension of slate PC: 273.5 mm x 176mm (with 10.1 inches LCD size ) 

c. Does not support Hot spot / Tethering functionality. 

d. WWAN Module : Sierra Gobi3000, Original FCC ID: N7NMC8355 submitted as                           
Fujitsu FCC ID: EJE-MC8355D 

i. Part 22/24 (No LTE) 

1. Frequency band: Cellular/PCS and AWS band 
2. GSM/GPRS / EDGE / UMTS/HSPA+ 
a) GPRS/EDGE Class 10 
b) HSDPA Rel 7 / Cat 10 
c) HSUPA Rel 6 Cat 6 

 
3. CDMA 2000:    a)1x       b) EVDO Release 0 and A 

 
e. WLAN Module 802.11 a/b/g/n (1x1) :  FCC ID: EJE-WL0025 - The WWAN and 

WLAN modules will not be able to transmit simultaneously with maximum hand-off 
duration less than 30 seconds hence simultaneous SAR evaluation is not applied. 

f.  Bluetooth Module : FCC ID: QDS-BRCM1043  Bluetooth 4.0 + Low power Energy 
(max 4dBm) 
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2.2 Antenna Location and Separation Distance 
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2.3 TEST PLAN  

a. RF conducted output power measurement – Max. Power and With Power back‐off 
(power reduced) comparison  

Original FCC ID  (Qualcomm)  J9CGOBI3000
FCC ID established via section 2.933 procedure 
(Sierra) 

N7NMC8355 

FCC ID established via section 2.933 procedure as 
required for Sensor based tablet PC (Fujitsu)

EJE‐MC8355D 

This application: Class II Permissive change (Fujitsu)  EJE‐MC8355D 
  

b. WiFi Portion  

No Power reduction for WiFi. Full power 
 
 
2.4 Referenced KDBs 
The tests will be performed in accordance with FCC OET Bulletin 65 Supplement C 01‐01, IEEE STD 
1528‐2003, and the following KDB procedures. (pre‐25th Oct 2012 released KDBs) 
 

- 941225 D01 SAR test for 3G devices v02 
- 941225 D03 SAR Test Reduction GSM/GPRS/EDGE vo1 
- 447498 D01 Mobile Portable RF Exposure v04 
- Power Reduction by sensing (April 2011, Oct 2011 and April 2012 TCBC workshop SAR 

Updates ) 
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2.5 SAR Test Configurations 

c. Slate Tablet Mode ( direct contact to flat phantom with 0 mm separation distance ) 

WWAN transmitter will be 
disabled in this Orientation / 
RF Tx OFF. Edge.  
SAR Test NOT performed 
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2.6 Summary of Test Configurations 

Configuration 
WWAN Ant-to-User 

distance 
SAR 

Require 
Comments 

(1) Edge 1 

Secondary 
Landscape 

3.6 mm No 

WWAN transmitter will be disabled in this Orientation / 
RF OFF hence non-functional. 
See section 5 for setup illustration. 

(2) Edge 4 

Secondary Portrait 
137 mm No 

SAR evaluation will not be performed for this 
configuration as this is not the most conservative 
edge. Testing as per KDB 447498 4) b) ii) (2). See 
section 5 for edge illustration. 

(3) Edge 3 

Primary Landscape 
168 mm No 

SAR evaluation will not be performed for this 
configuration as this is not the most conservative 
edge. Testing  as per KDB 447498 4) b) ii) (2) See 
section 5 for edge illustration. 

(4) Edge 2 

Primary Portrait 
53 mm Yes 

Worst case SAR evaluation performed with the EUT 
edge in direct contact with phantom flat section.). See 
Section 5 for setup illustration. 

(5) Edge 5.1 Lapheld 

Base (Back Surface) 
4.3 mm Yes 

SAR evaluation will be performed with the EUT 
surface in direct contact with phantom flat section. 
Tested with Power reduction, DPC mode Enabled. (0 
mm separation). See section 5 for setup illustration. 

(6) 

Edge 5.2 Lapheld 

Base (Back/Bottom 
Surface) 

4.3 mm  

+ 

5mm spacing 

 

Yes 

SAR evaluation will be performed with the EUT 
surface parallel to phantom with 5mm.  

Tested with Full Power, DPC mode Disabled. (5 mm 
separation). See section 5 for setup illustration. 

 
 
 
 
 
 
 
 
 

n  
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3.0 TEST SAMPLE TECHNICAL INFORMATION 

 (Information supplied by the client) 
 
3.1 WWAN Details 
Table 2 

Transmitter: WWAN (UMTS/EVDO combo)  
Model Number: Gobi3000 
Manufacturer: SIERRA WIRELESS INC 
Network Standard: GSM Release 6 /  
UMTS bands :  IMT 2100 / 850 / 1900MHz(Band Class I, II, V) 
GSM / EDGE bands:  850 / 900/ 1800 / 1900 MHz 
CDMA bands:  850 / 1900 MHz 
Channel spacing:  200Khz(GSM), 5MHz(WCDMA) 
Channel raster:  200kHz  
Antenna type:  Main: Monopole, AUX: PIFA 
Antenna Manufacturer:  NISSEI ELECTRIC CO. LTD.  
  

 
Test Signal, Frequency and Output Power 

 
The DUT was provided by Fujitsu Australia Pty Ltd.   It was put into operation using a Rohde & Schwarz Radio 
Communication Tester CMU200.  The channels utilised in the measurements were the traffic channels shown 
in the table below.  The power level was set to Class 4 for 850 MHz and Class 1 for 1900 MHz GSM bands, 
class 3 for 850, 1750 MHz and 1900 MHz UMTS bands, Power Class 3 for the 850 MHz (BC0) and Power 
Class 2 1900 MHz (BC1) CDMA bands. 
 

Channels and Output power: 

Table 3 

Channel and Mode 
 

Frequency  
MHz 

Average Output 
Power 
dBm 

GPRS Mode   
Channels 128, 190 and 251 824.2, 836.6 and 848.8 32.6 +/-1 dB 
Channels 512, 661 and 810 1850.2, 1880 and1909.8  28.5 +/- 0.5 dB 

UMTS Mode   
Channels 4132, 4183 and 4233 826.4, 836.6 and 846.6 23.5 +/- 0.5 dB 
Channels 9262, 9400 and 9538 1852.4, 1880 and 1907.6 23 +/- 0.5 dB 
Channels 1312, 1427 and 1513 1712.4, 1735.4 and 1752.6 22.5+/- 0.5 dB 

CDMA Mode   
Channels 1013, 384 and 777 824.7, 836.52 and 848.31 24 +/- 1 dB 
Channels 25, 600 and 1175 1851.25, 1880 and 1908.75 23+/- 0.5 dB 
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3.3 DUT (Notebook PC) Details 
 
The intention of this application is to certify WWAN module FCC ID: EJE-MC8355D and IC: 337J-MC8355D in 
a Fujitsu host PC model Q572 with WLAN model Ralink WLU5110-D50(ROHS) AND Bluetooth model 
BCM92070MD_REF6. 
 
SAR testing was conducted on the sample that is also equipped with the Bluetooth transmitter with antenna 
and Ralink WLAN modules with antenna. 
 
According to the manufacturer specifications the Bluetooth is a low power transmitter (4dBm), also Bluetooth 
Antenna is located >5cms from any other antenna in the system. The Antenna location is shown on page 5 of 
the report 

Table 4 

Host notebook : STYLISTIC  Q series  
Model Name: Q572 
Serial Number: Pre-production Sample 
Manufacturer: FUJITSU LIMITED 
  
CPU Type and Speed: AMD Z-60 APU 1.0GHz   
LCD 10.1”WXGA(1280x800 : LP101WH4-SLP1 
Graphics chip Non 
Wired LAN: Non 
Modem: Non 
Port Replicator Model: FPCPR202 
  
AC Adapter Model: 60W: PXW1931N(Tamura) 
Voltage: 19 V 
Current Specs: 3.16A  
Watts: 60W  
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3.4 Test sample Accessories 
 
3.4.1 Battery Types 
One type of Fujitsu Lithium Ion battery is used to power the DUT. 
 
Standard Battery      

Table 5 

Model Li-ion   
V/mAh 7.4V/5000mAh   
 
4.0 TEST SIGNAL, FREQUENCY AND OUTPUT POWER 
 
For the SAR measurements the DUT was operating at full transmit power. The fixed frequency channels used 
in the testing are shown in Tables Below. 
 
The frequency span of the GSM and UMTS bands was more than 10MHz consequently; the SAR levels of the 
test sample were measured for lowest, centre and highest channels in the applicable modes. There were no 
wires or other connections to the DUT during the SAR measurements.  
At the beginning of the SAR tests, the conducted power of the DUT was measured after temporary modification 
of antenna connector inside the DUT’s TX RX compartment. Measurements were performed with a calibrated 
Power Meter. The results of this measurement are listed in tables below. Burst Average power was used to 
calculate the Frame Average power (100% Duty Cycle) which determines the worst case Multislot Class.  
 
Gobi3000 - IMEI – 355096040071499 0dB Power Reduction 
 
Conducted Power Measurement CDMA 2000 1xRTT 850/1900 MHz 
 
Configuration: 
Network > System Parameters > System ID = 2004; Network Identity > Network ID Number = 65535 
 
Service cfg > Primary Service Class > Selected Service = Loopback Service; Primary Service Class > 
Loopback Service > Selected Service Option = Service Option x (x -  2, 9 or 55); Service Option x (x -  2, 9 or 
55) > FCH Config > Frames > Frame Rate = Full; Selected Service Option > Service Option 55 > FCH Config > 
FCH > F-FCH-MO = 0001hex (Fundamental Channel Test Mode 1) or 0002hex (Fundamental Channel Test Mode 2) 
 
Service cfg > Primary Service Class > Selected Service = Test Data Service; Primary Service Class > Test 
Data Service > Selected Service Option = Service Option 32; Test Data Service Option 32 > FCCH & SCH 
Config > SCH0 Enable = Off (or On); Test Data Service Option 32 > FCCH & SCH Config > SCH1 Enable = Off 
(or On); Test Data Service Option 32 > FCCH & SCH Config > SCH0 Config  >  Data Rate = 9.6 kbps; FCCH & 
SCH Config > SCH1 Config  >  Data Rate = 9.6 kbps 
 
BS Signal > RF Settings > RF Power > CDMA Power = -104 dBm/1.23MHz (RF > External attenuation IN/OUT 
as per cable losses); RF Settings > RF Channel [BC0] = 384; RF Settings > RF Channel [BC1] = 325; BS 
Signal > RF Settings > RF Power > PICH Level = -7dB; BS Signal > FCH > FCH Level = -7.4 dB 
BS Signal > Power Control > Power Ctrl. Bits = All Up (Service Options 2,9 and 55)  
BS Signal > Power Control > Power Ctrl. Bits = Hold (Service Options 32) 
 
Cellular Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 

1 N/A SO 2 N/A N/A 24.94 24.92 24.83 
1 N/A SO 55 N/A N/A 24.93 24.87 24.82 
2 N/A SO 9 N/A N/A 24.90 24.88 24.80 
2 N/A SO 55 N/A N/A 24.91 24.86 24.83 

N/A 3 N/A SO 32 OFF 24.89 24.89 24.79 
N/A 3 N/A SO 32 ON 24.91 24.90 24.84 

*SCH1 Enable – rejected by DUT 
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PCS Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 

1 N/A SO 2 N/A N/A 23.40 23.12 23.16 
1 N/A SO 55 N/A N/A 23.11 23.13 23.20 
2 N/A SO 9 N/A N/A 23.39 23.09 23.15 
2 N/A SO 55 N/A N/A 23.38 23.14 23.18 

N/A 3 N/A SO 32 OFF 23.37 23.11 23.17 
N/A 3 N/A SO 32 ON 23.38 23.10 23.18 

 
Conducted Power Measurement 1xEvDo Revision 0 850/1900 MHz 
 
Configuration: 
Network > Network Release = Release 0; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -105.5 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); 
RF Settings > RF Channel [BC0] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control 
bits = All Up 
Layer > Application Layer > Test Applications > FTAP Cfg > DRC > ACK Ch Fixed Mode = Ack.Always; 
DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > RTAP Cfg > Data > Min. Rate = 5 (153.6 
kbps); Data > Min. Rate = 5 (153.6 kbps) 
 
Cellular Band 

Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 
Ch. 1013 Ch. 384 Ch.777 

0 -81 dB 25.21 25.19 25.11 
 
PCS Band 

Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 
Ch. 25 Ch. 600 Ch.1175 

0 -84 dB 23.66 23.41 23.55 
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Conducted Power Measurement 1xEvDo Revision A 850/1900 MHz 
 
Configuration: 
Network > Network Release = Release A; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -60 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); RF 
Settings > RF Channel [BC0] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control bits 
= All Up 
Subtype 0: 
Layer > Protocol View Filter = Release 0 Settings; Layer > Application Layer > Test Applications > FTAP Cfg > 
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > 
RTAP Cfg > Data > Min. Rate = 5 (153.6 kbps); Data > Max. Rate = 5 (153.6 kbps) 
Subtype 2: 
Layer > Protocol View Filter = Release A Settings; Layer > Application Layer > Test Applications > FTAP Cfg > 
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Rate = 16 (307.2 kbps, 2-slots); Test Applications > RTAP 
Cfg > Data > Min. Packet Size = 9 (4096 bits); Data > Max. Packet Size = 9 (4096 bits); 
 
 
Cellular Band 

Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 
Ch. 1013 Ch. 384 Ch.777 

0 -81 dB N/A* N/A* N/A*
2 -81 dB 24.95 24.90 24.82 

 
PCS Band 

Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 
Ch. 25 Ch. 600 Ch.1175 

0 -84 dB N/A* N/A* N/A*
2 -84 dB 23.36 23.14 23.29 

*DUT has no Subtype 0 capabilities 
 

Table: Frequency and Conducted Power Results GSM 

Table 6 

Coding 
Scheme 

GPRS Multislot 
Class 

Number of Uplink 
Time-Slots 

RF Channel Measured Power 
Burst Average (dBm) 

Calculated Power 
Frame Average 

(100% Duty 
Cycle) 
(dBm) 

CS1 8 1 128 33.31 24.12 
CS1 8 1 190 33.35 24.16 
CS1 8 1 251 33.20 24.01 
CS1 10 2 128 33.37 27.19 
CS1 10 2 190 33.38 27.20 
CS1 10 2 251 33.21 27.03 
CS1 11 3 128 N/A* N/A*
CS1 11 3 190 N/A* N/A*
CS1 11 3 251 N/A* N/A*
CS1 12 4 128 N/A* N/A*
CS1 12 4 190 N/A* N/A*
CS1 12 4 251 N/A* N/A*
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Table 7 

Coding 
Scheme 

GPRS Multislot 
Class 

Number of Uplink 
Time-Slots 

RF Channel Measured Power 
Burst Average (dBm) 

Calculated Power 
Frame Average 

(100% Duty 
Cycle) 
(dBm) 

MCS5 8 1 128 27.47 18.28 
MCS5 8 1 190 27.52 18.33 
MCS5 8 1 251 27.57 18.38 
MCS5 10 2 128 27.83 21.65 
MCS5 10 2 190 27.81 21.63 
MCS5 10 2 251 27.66 21.48 
MCS5 11 3 128 N/A* N/A*
MCS5 11 3 190 N/A* N/A*
MCS5 11 3 251 N/A* N/A*
MCS5 12 4 128 N/A* N/A*
MCS5 12 4 190 N/A* N/A*
MCS5 12 4 251 N/A* N/A*

Table 8 

Coding 
Scheme 

GPRS Multislot 
Class 

Number of Uplink 
Time-Slots 

RF Channel Measured Power 
Burst Average (dBm) 

Calculated Power 
Frame Average 

(100% Duty 
Cycle) 
(dBm) 

CS1 8 1 512 28.51 19.32 
CS1 8 1 661 28.43 19.24 
CS1 8 1 810 28.16 18.97 
CS1 10 2 512 28.53 22.35 
CS1 10 2 661 28.44 22.26 
CS1 10 2 810 28.24 22.06 
CS1 11 3 512 N/A* N/A*
CS1 11 3 661 N/A* N/A*
CS1 11 3 810 N/A* N/A*
CS1 12 4 512 N/A* N/A*
CS1 12 4 661 N/A* N/A*
CS1 12 4 810 N/A* N/A*

Table 9 

Coding 
Scheme 

GPRS Multislot 
Class 

Number of Uplink 
Time-Slots 

RF Channel Measured Power 
Burst Average (dBm) 

Calculated Power 
Frame Average 

(100% Duty 
Cycle) 
(dBm) 

MCS5 8 1 512 24.53 15.34 
MCS5 8 1 661 24.75 15.56 
MCS5 8 1 810 24.45 15.26 
MCS5 10 2 512 24.57 18.39 
MCS5 10 2 661 24.80 18.62 
MCS5 10 2 810 24.47 18.29 
MCS5 11 3 512 N/A* N/A*
MCS5 11 3 661 N/A* N/A*
MCS5 11 3 810 N/A* N/A*
MCS5 12 4 512 N/A* N/A*
MCS5 12 4 661 N/A* N/A*
MCS5 12 4 810 N/A* N/A*

*DUT has no GPRS/EGPRS Multislot Class 11 and 12 capabilities 
 

Conducted Power Measurement UMTS 850 MHz 
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Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 
 

Channel No. βc βd Result (dBm) 
4132 8 15 24.98 
4183 8 15 24.97 
4233 8 15 24.84 

 
Conducted Power Measurement UMTS + HSDPA 850 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
  
Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR 

(dB) 4132 4183 4233 
1 2 15 8 8 8 24.46 24.47 24.45 0.0 
2 12 15 8 8 8 24.17 24.13 24.12 0.0 
3 15 8 8 8 8 24.00 23.98 23.95 0.5 
4 15 4 8 8 8 23.98 23.94 23.95 0.5 

 



 WWAN - FCC ID: EJE-MC8355D IC: 337J-MC8355D  Report No. M121125R2_FCC_MC8355_SAR_GSM-UMTS         Page 16 of 214 
  

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 
 
 

 
Conducted Power Measurement UMTS + HSDPA + HSUPA 850 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 
 

 
Conducted Power Measurement UMTS 1700 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 
 

Channel No. βc βd Result (dBm) 
1312 8 15 23.15 
1427 8 15 23.37 
1513 8 15 23.25 

 
Conducted Power Measurement UMTS + HSDPA 1700 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
 3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
 
Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR 

(dB) 1312 1427 1513 
1 2 15 8 8 8 22.71 22.87 22.75 0.0 
2 12 15 8 8 8 22.31 22.46 22.41 0.0 
3 15 8 8 8 8 22.24 22.36 22.30 0.5 
4 15 4 8 8 8 22.26 22.41 22.39 0.5 

 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 4132 4183 4233 

1 10 15 8 8 8 6 4 1 20 23.57 23.67 23.69 0.0 
2 6 15 8 8 8 8 4 1 12 22.01 22.12 22.01 2.0 
3 15 9 8 8 8 8 4 2 15 22.59 22.89 23.01 1.0 
4 2 15 8 8 8 5 4 1 17 22.06 22.15 22.07 2.0 
5 15 15 8 8 8 7 4 1 21 24.36 23.59 23.53 0.0 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 1700 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 
 

 
Conducted Power Measurement UMTS 1900 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 
 

Channel No. βc βd Result (dBm) 
9262 8 15 23.48 
9400 8 15 23.59 
9538 8 15 23.58 

 
Conducted Power Measurement UMTS + HSDPA 1900 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
 3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
 
Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR 

(dB) 9262 9400 9538 
1 2 15 8 8 8 23.01 23.14 23.11 0.0 
2 12 15 8 8 8 22.67 22.78 22.74 0.0 
3 15 8 8 8 8 22.50 22.67 22.69 0.5 
4 15 4 8 8 8 22.53 22.66 22.64 0.5 

 
 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 1312 1427 1513 

1 10 15 8 8 8 6 4 1 20 22.25 22.45 22.73 0.0 
2 6 15 8 8 8 8 4 1 12 20.52 20.62 20.67 2.0 
3 15 9 8 8 8 8 4 2 15 21.51 21.44 21.75 1.0 
4 2 15 8 8 8 5 4 1 17 20.86 20.76 20.85 2.0 
5 15 15 8 8 8 7 4 1 21 22.28 22.34 22.33 0.0 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 1900 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 9262 9400 9538 

1 10 15 8 8 8 6 4 1 20 22.32 22.81 22.71 0.0 
2 6 15 8 8 8 8 4 1 12 20.56 20.94 20.94 2.0 
3 15 9 8 8 8 8 4 2 15 21.61 21.75 21.88 1.0 
4 2 15 8 8 8 5 4 1 17 20.80 21.18 21.09 2.0 
5 15 15 8 8 8 7 4 1 21 22.10 22.67 22.33 0.0 
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Gobi3000 -5 dB Power reduction - IMEI – 355096040071499 
 
Conducted Power Measurement 1xEvDo Revision 0 850/1900 MHz 
 
Configuration: 
Network > Network Release = Release 0; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -105.5 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); 
RF Settings > RF Channel [BC0] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control 
bits = All Up 
Layer > Application Layer > Test Applications > FTAP Cfg > DRC > ACK Ch Fixed Mode = Ack.Always; 
DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > RTAP Cfg > Data > Min. Rate = 5 (153.6 
kbps); Data > Min. Rate = 5 (153.6 kbps) 
 
Cellular Band 

Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 
Ch. 1013 Ch. 384 Ch.777 

0 -81 dB 19.87 19.82 19.81 
 
PCS Band 

Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 
Ch. 25 Ch. 600 Ch.1175 

0 -84 dB 18.34 18.31 18.35 
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Conducted Power Measurement UMTS 850 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 
 

Channel No. βc βd Result (dBm) 
4132 8 15 20.39 
4183 8 15 20.38 
4233 8 15 20.21 

  
Conducted Power Measurement UMTS 1700 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 
 

Channel No. βc βd Result (dBm) 
1312 8 15 18.40 
1427 8 15 18.63 
1513 8 15 18.54 

 
Conducted Power Measurement UMTS 1900 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1sTable 10 
 

Channel No. βc βd Result (dBm) 
9262 8 15 18.49 
9400 8 15 18.85 
9538 8 15 18.82 

 



 WWAN - FCC ID: EJE-MC8355D IC: 337J-MC8355D  Report No. M121125R2_FCC_MC8355_SAR_GSM-UMTS         Page 21 of 214 
  

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 
 
 

 
4.1 Battery Status 
The DUT battery was fully charged prior to commencement of measurement.  Each SAR test was completed 
within 30 minutes.  The battery condition was monitored by measuring the RF field at a defined position inside 
the phantom before the commencement of each test and again after the completion of the test. It was not 
possible to perform conducted power measurements at the output of the DUT, at the beginning and end of 
each scan due to lack of a suitable antenna port. The uncertainty associated with the power drift was less than 
5% and was assessed in the uncertainty budget. 
 
5.0 DETAILS OF TEST LABORATORY 
 
5.1 Location 
EMC Technologies Pty Ltd  
176 Harrick Road 
Keilor Park, (Melbourne) Victoria 
Australia 3042 
  
Telephone: +61 3 9365 1000 
Facsimile: +61 3 9331 7455 
email:  melb@emctech.com.au 
website: www.emctech.com.au 
 
5.2 Accreditations 
EMC Technologies Pty. Ltd. is accredited by the National Association of Testing Authorities, Australia (NATA).  
NATA Accredited Laboratory Number: 5292 
 
EMC Technologies Pty Ltd is NATA accredited for the following standards: 

Table 11 

AS/NZS 2772.2: RF and microwave radiation hazard measurement 
ACMA: Radio communications (Electromagnetic Radiation - Human Exposure) Standard 2003 
FCC: Guidelines for Human Exposure to RF Electromagnetic Field OET65C 01/01 
EN 50360: 2001 Product standard to demonstrate the compliance of mobile phones with the basic 

restrictions related to human exposure to electromagnetic fields (300 MHz – 3 GHz) 
EN 62209-1: 2006 Human Exposure to radio frequency fields from hand-held and body-mounted wireless 

communication devices - Human models instrumentation and procedures. 
Part 1: Procedure to determine the specific absorption rate (SAR) for hand-held devices 
used in close proximity to the ear (300 MHz to 3 GHz) 

EN 62209-2:2010 Human Exposure to radio frequency fields from hand-held and body-mounted wireless 
communication devices - Human models instrumentation and procedures 
Part 2: Procedure to determine the specific absorption rate (SAR) for wireless 
communication devices used in close proximity to the human body (frequency range of 30 
MHz to 6 GHz 

IEEE 1528: 2003 Recommended Practice for Determining the Peak Spatial-Average Specific Absorption 
Rate (SAR) in the Human Head Due to Wireless Communications Devices: Measurement 
Techniques. 

Refer to NATA website www.nata.asn.au for the full scope of accreditation. 
 
5.3 Environmental Factors 
The measurements were performed in a shielded room with no background RF signals. The temperature in the 
laboratory was controlled to within 21±1°C, the humidity was in the range 41% to 51%. The liquid parameters 
are measured daily prior to the commencement of each test.  Tests were performed to check that reflections 
within the environment did not influence the SAR measurements. The noise floor of the DASY5 SAR 
measurement system using the SN3563 probe was less than 5μV in both air and liquid mediums. 
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6.0 DESCRIPTION OF SAR MEASUREMENT SYSTEM 
Table 12 

Applicable Head Configurations : None
Applicable Body Configurations : Lap Held Position 

: Edge On Position 
 
6.1 Probe Positioning System 
The measurements were performed with the state-of-the-art automated near-field scanning system DASY5 
Version 52 from Schmid & Partner Engineering AG (SPEAG). The DASY5 fully complies with the OET65 C (01-
01), IEEE 1528 and EN62209-1 and EN62209-2 SAR measurement requirements.  
 
6.2 E-Field Probe Type and Performance 
The SAR measurements were conducted with SPEAG dosimetric probe EX3DV4 Serial: 3563. Please refer to 
appendix C for detailed information. 
 
6.3 Validation 
 
6.3.1 Validation Results (900 MHz and 1800 MHz and 1950 MHz) 
 
The following tables lists the dielectric properties of the tissue simulating liquid measured prior to SAR 
validation. The results of the validation are listed in columns 4 and 5. The forward power into the reference 
dipole for SAR validation was adjusted to 250 mW. 
 
Table: Validation Results 

Table 13 

1. Validation Date 
& Frequency 

2. ∈r 
(measured) 

3. σ (mho/m) 
(measured) 

4. Measured 
SAR 1g (mW/g) 

5. Measured SAR 
10g (mW/g) 

4th Dec. 2012 
1950 MHz 51.0 1.60 10.6 5.33 

5th Dec. 2012 
1950 MHz 53.0 1.59 10.3 5.22 

6th Dec. 2012 
1800 MHz 51.0 1.54 10.5 5.48 

7th Dec. 2012 
900 MHz 52.5 1.04 2.82 1.84 

10th Dec. 2012 
900 MHz 53.5 1.06 2.94 1.91 
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6.3.2 Deviation from reference validation values 
 
The SPEAG calibration reference SAR value is the SAR validation result obtained in a specific dielectric liquid 
using the validation dipole during calibration. The measured one-gram SAR should be within 10% of the 
expected target reference values shown in table below. 
 
Table: Deviation from reference validation values @ (900MHz, 1800 MHz and 1950 MHz) 

Table 14 

Frequency 
and Date  

Measured 
SAR 1g 
(mW/g)  

Measured 
SAR 1g 
(Normalized 
to 1W) 

SPEAG 
Calibration 
reference 
SAR Value 
1g (mW/g) 

Deviation 
From 
SPEAG 
Reference 
1g (%) 

7th Dec. 2012 
900 MHz  2.82 11.28 11.1 1.62 

10th Dec. 2012 
900 MHz 2.94 11.76 11.1 5.95 

6th Dec. 2012 
1800 MHz 10.5 42.00 38.7 8.53 

4th Dec. 2012 
1950 MHz 10.6 42.40 38.8 9.28 

5th Dec. 2012 
1950 MHz  10.3 41.20 38.8 6.19 

NOTE: All reference validation values are referenced to 1W input power. 
 
6.3.3 Liquid Depth 15cm 

 
During the SAR measurement process the liquid level was maintained to a level of 15cm with a 
tolerance of 0.5cm.  
 

 
Photo of liquid Depth in Flat Phantom 
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6.4 Phantom Properties 
The phantoms used during the testing comply with the OET65 C (01-01), IEEE 1528 and EN62209-1 and 
EN62209-2 SAR measurement requirements.  
 
Phantom Properties Required Measured   
Thickness of flat section 2.0mm ± 0.2mm (bottom section) 2.12-2.20mm 
Dielectric Constant <5.0 4.603 @ 300MHz (worst-case frequency) 
Loss Tangent <0.05 0.0379 @ 2500MHz (worst-case frequency) 
 
6.5 Tissue Material Properties 
The dielectric parameters of the human tissue simulating liquid were measured prior to SAR assessment using 
the HP85070A dielectric probe kit, and HP8753ES Network Analyser.  The actual dielectric parameters are 
shown in the following table. 
 

Table: Measured Body Simulating Liquid Dielectric Values for Validations 

Table 15 

Frequency 
Band 

∈r (measured 
range) 

∈r 
(target) 

σ (mho/m) 
(measured 

range) 

σ 
(target) 

ρ 
kg/m3 

900 MHz 
Body 52.5 – 53.5 55.0 ±5% 

(52.3 to 57.8) 1.04 – 1.06 1.05 ±5% 
(1.00 to 1.10) 1000 

1800 MHz 
Body 51.0 53.3 ±5% 

(50.6 to 56.0) 1.54 1.52 ±5% 
(1.44 to 1.60) 1000 

1950 MHz 
Body 51.0 – 53.0 53.3 ±5% 

(50.6 to 56.0) 1.59 – 1.60 1.52 ±5% 
(1.44 to 1.60) 1000 

NOTE: The Body liquid parameters were within the required tolerances of ±5%.   
 
 

Table: Measured Body Simulating Liquid Dielectric Values at 850MHz 

Table 16 

Frequency 
Band 

∈r (measured 
range) 

∈r 
(target) 

σ (mho/m) 
(measured 

range) 

σ 
(target) 

ρ 
kg/m3 

825 MHz 
Body 53.2 – 54.2 55.2 ±5% 

(52.4 to 58.0) 0.96 – 0.98 0.97 ±5% 
(0.92 to 1.02) 1000 

835 MHz 
Body 53.2 – 54.1 55.2 ±5% 

(52.4 to 58.0) 0.97 – 0.99 0.97 ±5% 
(0.92 to 1.02) 1000 

850 MHz 
Body 53.1 – 53.9 55.2 ±5% 

(52.4 to 58.0) 0.99 – 1.01 0.97 ±5% 
(0.92 to 1.02) 1000 

Note:  The body liquid parameters were within the required tolerances of ±5%.   
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Table: Measured Body Simulating Liquid Dielectric Values at 1880MHz 

Table 17 

Frequency 
Band 

∈r (measured 
range) 

∈r 
(target) 

σ (mho/m) 
(measured 

range) 

σ 
(target) 

ρ 
kg/m3 

1850 MHz 
Body 51.4 – 53.4 53.3 ±5% 

(50.6 to 56.0) 1.55 – 1.56 1.52 ±5% 
(1.44 to 1.60) 1000 

1880.0 MHz 
Body 51.3 – 53.3 53.3 ±5% 

(50.6 to 56.0) 1.56 – 1.57 1.52 ±5% 
(1.44 to 1.60) 1000 

1910 MHz 
Body 51.1 – 53.2 53.3 ±5% 

(50.6 to 56.0) 1.58 – 1.59 1.52 ±5% 
(1.44 to 1.60) 1000 

Note:  The body liquid parameters were within the required tolerances of ±5%.   
 

Table: Measured Body Simulating Liquid Dielectric Values at 1735MHz 

Table 18 

Frequency 
Band 

∈r (measured 
range) 

∈r 
(target) 

σ (mho/m) 
(measured 

range)

σ 
(target) 

ρ 
kg/m3 

1712 MHz 
Body 51.3 53.3 ±5% 

(50.6 to 56.0) 1.48 1.52 ±5% 
(1.44 to 1.60) 1000 

1735 MHz 
Body 51.3 53.3 ±5% 

(50.6 to 56.0) 1.50 1.52 ±5% 
(1.44 to 1.60) 1000 

1750 MHz 
Body 51.2 53.3 ±5% 

(50.6 to 56.0) 1.51 1.52 ±5% 
(1.44 to 1.60) 1000 

Note:  The body liquid parameters were within the required tolerances of ±5%.   
 

6.5.1 Liquid Temperature and Humidity 
The humidity and dielectric/ambient temperatures were recorded during the assessment of the tissue material 
dielectric parameters. The difference between the ambient temperature of the liquid during the dielectric 
measurement and the temperature during tests was less than |2|°C. 
 
Table: Temperature and Humidity recorded for each day 

Table 19 

Date Ambient 
Temperature (°C) 

Liquid Temperature 
(°C) 

Humidity (%) 

4th Dec. 2012 21.4 21.0 51.0 
5th Dec. 2012 20.9 20.5 46.0 
6th Dec. 2012 21.2 20.9 41.0 
7th Dec. 2012 21.4 20.1 45.0 
10th Dec. 2012 20.8 20.4 46.0 
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6.6 Simulated Tissue Composition Used for SAR Test 
The tissue simulating liquids are created prior to the SAR evaluation and often require slight modification each 
day to obtain the correct dielectric parameters. 
 

Tissue Type: Body @ 850/900MHz  Tissue Type: Body @ 1800/1950MHz MHz 
  Volume of Liquid: 30 Litres      Volume of Liquid: 30 Litres 

Table 20 

Approximate 
Composition 

% By Weight  Approximate 
Composition 

% By Weight 

Distilled Water 56 Distilled Water 40.4
Salt  0.76  Salt  0.5 
Sugar 41.76  Sugar 58 
HEC 1.21  HEC 1 
Bactericide 0.27  Bactericide 0.1 

*Refer “OET Bulletin 65 97/01 P38” 
 
6.7 Device Holder for Laptops and P 10.1 Phantom 
A low loss clamp was used to position the DUT underneath the phantom surface. 
 
Refer to Appendix A for photographs of device positioning 
 
7 SAR MEASUREMENT PROCEDURE USING DASY5 
 
The SAR evaluation was performed with the SPEAG DASY5 system.  A summary of the procedure follows:
  

a) A measurement of the SAR value at a fixed location is used as a reference value for assessing the 
power drop of the DUT.  The SAR at this point is measured at the start of the test, and then again at the 
end of the test. 
 

b) The SAR distribution at the exposed flat section of the flat phantom is measured at a distance of 4 mm 
from the inner surface of the shell.  The area covers the entire dimension of the DUT and the horizontal 
grid spacing is 15 mm x 15 mm. The actual Area Scan has dimensions of 90 mm x 150 mm 
surrounding the test device. Based on this data, the area of the maximum absorption is determined by 
Spline interpolation. 

 
c) Around this point, a volume of 30 mm x 30 mm x 30 mm is assessed by measuring 7 x 7 x 7 points.  On 

the basis of this data set, the spatial peak SAR value is evaluated with the following procedure: 
 

(i) The data at the surface are extrapolated, since the centre of the dipoles is 1.0 mm away from the 
tip of the probe and the distance between the surface and the lowest measuring point is 4.0 mm.  
The extrapolation is based on a least square algorithm.  A polynomial of the fourth order is 
calculated through the points in z-axes.  This polynomial is then used to evaluate the points 
between the surface and the probe tip. 

 
(ii) The maximum interpolated value is searched with a straightforward algorithm.  Around this 

maximum the SAR values averaged over the spatial volumes (1 g and 10 g) are computed using 
the 3D-Spline interpolation algorithm.  The 3D-Spline is composed of three one-dimensional 
splines with the “Not a knot”- condition (in x, y and z-direction).  The volume is integrated with the 
trapezoidal – algorithm.  One thousand points (10 x 10 x 10) are interpolated to calculate the 
averages. 

 
(iii) All neighbouring volumes are evaluated until no neighbouring volume with a higher average value 

is found. 
 

(iv)  The SAR value at the same location as in Step (a) is again measured to evaluate the actual  power 
drift. 
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8 MEASUREMENT UNCERTAINTY  
 

The uncertainty analysis is based on the template listed in the IEEE Std 1528-2003 for both Handset SAR tests 
and Validation uncertainty. The measurement uncertainty of a specific device is evaluated independently and 
the total uncertainty for both evaluations (95% confidence level) must be less than 30%. 
 

Table 21:  Uncertainty Budget for DASY5 Version 52 – DUT SAR 

Error Description Uncert. 
Value 

Prob. 
Dist. Div. Ci (1g) Ci 

(10g) 1g ui 10g ui  vi 

Measurement System                 
Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 
Axial Isotropy 4.7 R 1.73 0.7 0.7 1.90 1.90 ∞ 
Hemispherical Isotropy 9.6 R 1.73 0.7 0.7 3.88 3.88 ∞ 
Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 
Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 
System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 
Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 
Response Time 0.8 R 1.73 1 1 0.46 0.46 ∞ 
Integration Time 2.6 R 1.73 1 1 1.50 1.50 ∞ 
RF Ambient Noise 3 R 1.73 1 1 1.73 1.73 ∞ 
RF Ambient Reflections 3 R 1.73 1 1 1.73 1.73 ∞ 
Probe Positioner  0.4 R 1.73 1 1 0.23 0.23 ∞ 
Probe Positioning 2.9 R 1.73 1 1 1.67 1.67 ∞ 
Max. SAR Eval. 1 R 1.73 1 1 0.58 0.58 ∞ 
Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 
Test Sample Related                 
Power Scaling 0 R 1.73 1 1 0.00 0.00 ∞ 
Test Sample Positioning 2.9 N 1.00 1 1 2.90 2.90 145 
Device Holder Uncertainty 3.6 N 1.00 1 1 3.60 3.60 5 
Output Power Variation – SAR Drift 
Measurement 4.28 R 1.73 1 1 2.47 2.47 ∞ 

Phantom and Setup                 
Phantom Uncertainty 7.5 R 1.73 1 1 4.33 4.33 ∞ 
Liquid Conductivity – Deviation from target 
values 5 R 1.73 0.64 0.43 1.85 1.24 ∞ 

Liquid Permittivity – Deviation from target 
values 5 R 1.73 0.6 0.49 1.73 1.41 ∞ 

Liquid Conductivity – Measurement 
uncertainty 2.5 N 1.00 0.64 0.71 1.60 1.78 ∞ 

Liquid Permittivity – Measurement 
uncertainty 2.5 N 1.00 0.6 0.26 1.50 0.65 ∞ 

Temp.unc. - Conductivity 1.7 R 1.73 0.78 0.71 0.77 0.70 ∞ 
Temp. unc. - Permittivity 0.3 R 1.73 0.23 0.26 0.04 0.05 ∞ 
Combined standard Uncertainty (uc)           11.6 11.4   
Expanded Uncertainty (95% CONFIDENCE 
LEVEL)     k= 2   23.1 22.8   

Estimated total measurement uncertainty for the DASY5 measurement system was ±11.6%.  The extended 
uncertainty (K = 2) was assessed to be ±23.1% based on 95% confidence level.  The uncertainty is not added 
to the measurement result.   
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Table 22: Uncertainty Budget for DASY5 Version 52 – Validation 

Error Description Uncert. 
Value 

Prob. 
Dist. Div. Ci (1g) Ci 

(10g) 1g ui 10g ui  vi 

Measurement System                 
Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 
Axial Isotropy 4.7 R 1.73 1 1 2.71 2.71 ∞ 
Hemispherical Isotropy 9.6 R 1.73 0 0 0.00 0.00 ∞ 
Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 
Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 
System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 
Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 
Response Time 0 R 1.73 1 1 0.00 0.00 ∞ 
Integration Time 0 R 1.73 1 1 0.00 0.00 ∞ 
RF Ambient Noise 1 R 1.73 1 1 0.58 0.58 ∞ 
RF Ambient Reflections 1 R 1.73 1 1 0.58 0.58 ∞ 
Probe Positioner  0.8 R 1.73 1 1 0.46 0.46 ∞ 
Probe Positioning 6.7 R 1.73 1 1 3.87 3.87 ∞ 
Max. SAR Eval. 2 R 1.73 1 1 1.15 1.15 ∞ 
Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 
Dipole Related                 
                  
Deviation of exp. dipole 5.5 R 1.73 1 1 3.18 3.18 ∞ 
Dipole Axis to Liquid Dist. 2 R 1.73 1 1 1.15 1.15 ∞ 
Input power & SAR drift 3.40 R 1.73 1 1 1.96 1.96 ∞ 
Phantom and Setup                 
Phantom Uncertainty 4 R 1.73 1 1 2.31 2.31 ∞ 
Liquid Conductivity – Deviation from target 
values 5 R 1.73 0.64 0.43 1.85 1.24 ∞ 

Liquid Permittivity – Deviation from target 
values 5 R 1.73 0.6 0.49 1.73 1.41 ∞ 

Liquid Conductivity – Measurement 
uncertainty 2.5 N 1.00 0.78 0.71 1.95 1.78 ∞ 

Liquid Permittivity – Measurement uncertainty 2.5 N 1.00 0.26 0.26 0.65 0.65 ∞ 
Temp.unc. - Conductivity 1.7 R 1.73 0.78 0.71 0.77 0.70 ∞ 
Temp. unc. - Permittivity 0.3 R 1.73 0.23 0.26 0.04 0.05 ∞ 
Combined standard Uncertainty (uc)           10.1 9.9   
Expanded Uncertainty (95% CONFIDENCE 
LEVEL)     k= 2   20.2 19.8   

Estimated total measurement uncertainty for the DASY5 measurement system was ±10.1%.  The extended 
uncertainty (K = 2) was assessed to be ±20.2% based on 95% confidence level.  The uncertainty is not added 
to the Validation measurement result.   
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9 EQUIPMENT LIST AND CALIBRATION DETAILS 
 

Table 23: SPEAG DASY5 Version 52 

Equipment Type Manufacturer Model Number Serial Number Calibration 
Due 

Used For 
this Test? 

Robot - Six Axes Staubli RX90BL N/A Not applicable  

Robot Remote Control SPEAG CS7MB RX90B Not applicable  

SAM Phantom SPEAG N/A 1260 Not applicable  

SAM Phantom SPEAG N/A 1060 Not applicable  

Flat Phantom  AndreT 10.1 P 10.1 Not Applicable  

Flat Phantom  AndreT  9.1 P 9.1 Not Applicable  

Flat Phantom  SPEAG ELI 4.0 1101 Not Applicable  

Data Acquisition Electronics SPEAG DAE3 V1 359 21-June-2013  

Data Acquisition Electronics SPEAG DAE3 V1 442 05-Dec-2012  

Probe E-Field - Dummy SPEAG DP1 N/A Not applicable  

Probe E-Field SPEAG ET3DV6 1380 12-Dec-2012  

Probe E-Field SPEAG ET3DV6 1377 20-June-2013  

Probe E-Field SPEAG ES3DV6 3029 Not Used  

Probe E-Field SPEAG EX3DV4 3563 21-June-2013  

Probe E-Field SPEAG EX3DV4 3657 14-Dec-2012  

Antenna Dipole 300 MHz SPEAG D300V3 1012 30-Nov-2012  

Antenna Dipole 450 MHz SPEAG D450V3 1074 30-Nov-2012  

Antenna Dipole 750 MHz SPEAG D750V2 1051 9-Jan-2014  

Antenna Dipole 900 MHz SPEAG D900V2 047 22-June-2014  

Antenna Dipole 1640 MHz SPEAG D1640V2 314 20-June-2014  

Antenna Dipole 1800 MHz SPEAG D1800V2 242 20-June-2014  

Antenna Dipole 1950 MHz SPEAG D1950V3 1113 10-Dec -2012  

Antenna Dipole 2450 MHz SPEAG D2450V2 724 09-Dec-2012  

Antenna Dipole 2600 MHz SPEAG D2600V2 1044 10-Jan-2014  

Antenna Dipole 3500 MHz SPEAG D3500V2 1002 13-July-2013  

Antenna Dipole 5600 MHz SPEAG D5GHzV2 1008 14-Dec-2013  

RF Amplifier  EIN 603L N/A *In test   

RF Amplifier  Mini-Circuits ZHL-42 N/A *In test   

RF Amplifier  Mini-Circuits ZVE-8G N/A *In test   

Synthesized signal generator Hewlett Packard ESG-D3000A GB37420238 *In test  

RF Power Meter Hewlett Packard 437B 3125012786 30-Aug-2013  

RF Power Sensor 0.01 - 18 GHz Hewlett Packard 8481H 1545A01634 03-Sept-2013  

RF Power Meter Rohde & Schwarz NRP 101415 17-Sept-2013  

RF Power Sensor Rohde & Schwarz NRP - Z81 100174     17-Sept-2013  

RF Power Meter Dual Hewlett Packard 435A 1733A05847 *In test  

RF Power Sensor Hewlett Packard 8482A 2349A10114 *In test  

Network Analyser Hewlett Packard 8714B GB3510035 27-Sept-2013  

Network Analyser Hewlett Packard 8753ES JP39240130 5-Nov-2013  

Dual Directional Coupler Hewlett Packard 778D 1144 04700 *In test  

Dual Directional Coupler  NARDA 3022 75453 *In test  

Radio Communication Test Set Rohde & Schwarz CMU200 101573 Not Applicable  

Radio Communication Test Set Anritsu MT8820A 6200240559 Not Applicable  

Radio Communication Test Set Agilent PXT E6621A MY51100168 Not Applicable  

* Calibrated during the test for the relevant parameters. 
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10 TEST METHODOLOGY 
Notebooks should be evaluated in normal use positions, typical for lap-held bottom-face only. However the 
number of positions will depend on the number of configurations the tablet can be operated in. The “STYLISTIC 
Q SERIES” PC can be used on the lap (see Appendix A) or hand held as a Tablet PC. 
 
10.1 “Lap Held” Position Definition (0mm spacing) 
The DUT was tested in the 2.00 mm flat section of the AndreT Flat phantom for the “Lap Held” position. The 
Transceiver was placed at the bottom of the phantom and suspended in such way that the back of the DUT 
was touching the phantom. This device orientation simulates the PC’s normal use – being held on the lap of the 
user.  
 
10.2 “Edge On” Position 
The DUT was tested in the (2.00 mm) flat section of the AndreT Flat phantom for the “Edge On” position. The 
Antenna edge of the Transceiver was placed underneath the flat section of the phantom and suspended until 
the edge touched the phantom. Refer to Appendix A for photos of measurement positions. 
 
10.3  List of All Test Cases (Antenna In/Out, Test Frequencies, User Modes) 
The DUT has a fixed antenna. Depending on the measured SAR level up to three test channels with the test 
sample operating at maximum power were recorded. The following table represents the matrix used to 
determine what testing was required. All relevant provisions of KDB 447498 and KDB 941225 are applied for 
SAR measurements of the host system. Due to the screen size <12 inches, KDB 616217 was not used in the 
SAR evaluation instead “Supplement to the KDB 616217” was followed.  
 
Table: Testing configurations 

Table 24 

Phantom 
Configuration  

Device Mode 
WWAN Band Name  

Test Configurations 
Channel 
(Low) 

Channel 
(Middle) 

Channel 
(High) 

Lap Held GPRS 850 MHz   x  
 GPRS 1900 MHz  x  
 Ev-Do 850 MHz  x  
 Ev-Do 1900 MHz  x  
 WCDMA 850 MHz   x  
 WCDMA 1735 MHz   x  
 WCDMA 1900 MHz  x  
Edge On GPRS 850 MHz   x  
 GPRS 1900 MHz  x  
 Ev-Do 850 MHz  x  
 Ev-Do 1900 MHz  x  
 WCDMA 850 MHz   x  
 WCDMA 1735 MHz   x  
 WCDMA 1900 MHz  x  
 
Legend 

X Testing Required in this configuration 
  
 Testing required in this configuration only if SAR of middle channel is more than 3dB 

below the SAR limit or it is the worst case. 
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11 SAR MEASUREMENT RESULTS 
 
The SAR values averaged over 1g tissue masses were determined for the sample DUT for all test 
configurations listed in section 10.2.  
 

11.1  SAR Results 
 

There are three modes of operation which include UMTS, GPRS and Ev-Do transmission. Table below displays 
the SAR results. 
 

Table: SAR MEASUREMENT RESULTS – 850MHz GPRS 

Table 25 

NOTE: The measurement uncertainty of 23.1% was not added to the result. 
 
The highest SAR level recorded was 1.33 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF  in GPRS mode, utilizing channel 251 (849 MHz).  
 

Table: SAR MEASUREMENT RESULTS – 1900MHz GPRS 

Table 26 

NOTE: The measurement uncertainty of 23.1% was not added to the result. 
 

The highest SAR level recorded was 1.54 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF  in GPRS mode, utilizing channel 810 (1909.8 
MHz).  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test 
Freq 
(MHz) 

Number 
of Time 
Slots 

Measured 
Burst avr. 
power (dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Lap Held 0mm 
Spacing DPC ON 

1 128 824 2 28.92 0.685 0.01 
2 190 836 2 28.69 0.726 -0.03 
3 251 849 2 28.69 0.826 -0.06 

        

Lap Held 5mm 
Spacing DPC OFF 

4 128 824 2 33.37 1.03 -0.01 
5 190 836 2 33.38 1.18 0.00 
6 251 849 2 33.21 1.33 -0.01 

        

Edge # 2 - Primary 
Portrait  

7 128 824 2 33.37 0.093 0.03 
8 190 836 2 33.38 0.087 -0.04
9 251 849 2 33.21 0.099 -0.10 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test 
Freq 
(MHz) 

Number 
of Time 
Slots 

Measured 
Burst avr. 
power (dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Lap Held 0mm 
Spacing DPC ON 

10 512 1850.2 2 23.54 0.946 -0.06 
11 661 1880 2 23.82 1.36 -0.11 
12 810 1909.8 2 23.38 1.53 0.03 

        

Lap Held 5mm 
Spacing DPC OFF 

13 512 1850.2 2 28.53 1.21 -0.03 
14 661 1880 2 28.44 1.50 0.05 
15 810 1909.8 2 28.24 1.54 0.05 

        

Edge # 2 - Primary 
Portrait 

16 512 1850.2 2 28.53 0.359 0.07 
17 661 1880 2 28.44 0.421 -0.01 
18 810 1909.8 2 28.24 0.431 0.09 
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Table: SAR MEASUREMENT RESULTS – 850MHz UMTS 

Table 27 

(*): SAR compensated with respect to +5% tolerance in ∈r and -5% tolerance in σ 
NOTE: The measurement uncertainty of 23.1% was not added to the result. 

 
The highest SAR level recorded was 0.673 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF in UMTS mode, utilizing channel 4233 (846.6 MHz).  

 
Table: SAR MEASUREMENT RESULTS – 1735MHz UMTS 

Table 28 

(*): SAR compensated with respect to +5% tolerance in ∈r and -5% tolerance in σ 
NOTE: The measurement uncertainty of 23.1% was not added to the result. 

 
The highest SAR level recorded was 1.47 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF in UMTS mode, utilizing channel 1427 (1735.4 
MHz).  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 
average power 
(dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured Drift 
(dB) 

Lap Held 0mm 
Spacing DPC ON 

19 4132 826.4 20.39 0.373* 0.02 
20 4183 836.6 20.38 0.436 -0.07 
21 4233 846.6 20.21 0.482 -0.07 

       

Lap Held 5mm 
Spacing DPC OFF 

22 4132 826.4 24.98 0.543* 0.07 
23 4183 836.6 24.97 0.602 0.05 
24 4233 846.6 24.84 0.673 0.03 

       

Edge # 2 - Primary 
Portrait 

25 4132 826.4 24.98 0.018* 0.13 
26 4183 836.6 24.97 0.016 -0.19 
27 4233 846.6 24.84 0.019 0.16 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 
average power 
(dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured Drift 
(dB) 

Lap Held 0mm 
Spacing DPC ON 

28 1312 1712.4 18.40 1.13* -0.09 
29 1427 1735.4 18.63 1.23* -0.07 
30 1513 1752.6 18.54 1.25* 0.07 

       

Lap Held 5mm 
Spacing DPC OFF 

31 1312 1712.4 23.15 1.36* -0.07 
32 1427 1735.4 23.37 1.47* -0.07 
33 1513 1752.6 23.25 1.45* -0.07 

       

Edge # 2 - Primary 
Portrait 

34 1312 1712.4 23.15 0.280* -0.13 
35 1427 1735.4 23.37 0.335* -0.08 
36 1513 1752.6 23.25 0.371* -0.05 
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Table: SAR MEASUREMENT RESULTS – 1900MHz UMTS 

Table 29 

NOTE: The measurement uncertainty of 23.1% was not added to the result. 
 
 
The highest SAR level recorded was 1.51 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF in UMTS mode, utilizing channel 9538 (1907.6 
MHz).  

 
Table: SAR MEASUREMENT RESULTS – 850MHz Ev-Do Rev.0 

Table 30 

NOTE: The measurement uncertainty of 23.1% was not added to the result. 
 
 
The highest SAR level recorded was 0.757 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF in Ev-Do mode, utilizing channel 0777 (848.31 
MHz). 
 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 
average power 
(dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured Drift 
(dB) 

Lap Held 0mm 
Spacing DPC ON 

37 9262 1852.4 18.49 1.34 -0.15 
38 9400 1880 18.85 1.32 0.04 
39 9538 1907.6 18.82 1.50 0.06 

       

Lap Held 5mm 
Spacing DPC OFF 

40 9262 1852.4 23.48 1.34 0.03 
41 9400 1880 23.59 1.34 0.10 
42 9538 1907.6 23.58 1.51 -0.03 

       

Edge # 2 - Primary 
Portrait 

43 9262 1852.4 23.48 0.403 0.12 
44 9400 1880 23.59 0.435 0.03 
45 9538 1907.6 23.58 0.597 -0.01 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 
average power 
(dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured Drift 
(dB) 

Lap Held 0mm 
Spacing DPC ON 

46 1013 824.7 19.87 0.391 0.02 
47 0384 836.52 19.82 0.476 -0.05 
48 0777 848.31 19.81 0.521 -0.02 

       

Lap Held 5mm 
Spacing DPC OFF 

49 1013 824.7 25.21 0.540 -0.15 
50 0384 836.52 25.19 0.613 -0.05 
51 0777 848.31 25.11 0.757 0.01 

       

Edge # 2 - Primary 
Portrait 

52 1013 824.7 25.21 0.042 0.17 
53 0384 836.52 25.19 0.040 -0.17 
54 0777 848.31 25.11 0.048 -0.14 
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Table: SAR MEASUREMENT RESULTS – 1900MHz Ev-Do Rev.0 

Table 31 

NOTE: The measurement uncertainty of 23.1% was not added to the result. 
 
 
The highest SAR level recorded was 1.14 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in Lap Held 5mm Spacing position with DPC OFF in Ev-Do mode, utilizing channel 600 (1880 MHz). 
 
 
 
12   COMPLIANCE STATEMENT 
 
The Fujitsu Tablet PC, Model: Q572 with SIERRA WIRELESS Mini-PCI Wireless WAN Module (Gobi 3000), 
Model MC8355 was found to comply with the FCC and RSS-102 SAR requirements.  
 
The highest SAR level recorded was 1.54 mW/g for a 1g cube. This value was measured at 1909.8 MHz 
(channel 810) in the Lap Held 5mm Spacing position with DPC OFF in GPRS transmission mode. This was 
below the limit of 1.6 mW/g for uncontrolled exposure, but was within the band of measurement uncertainty 
around the limit. 
 
 
 
 
13 MULTIBAND EVALUATION CONSIDERATIONS 
  
No simultaneous transmission of WWAN and WLAN is possible for the Fujitsu Tablet PC, Model: Q572.  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 
average power 
(dBm) 

Measured 1g 
SAR Results 
(mW/g) 

Measured Drift 
(dB) 

Lap Held 0mm 
Spacing DPC ON 

55 0025 1851.25 18.34 0.806 -0.03 
56 0600 1880 18.31 0.893 -0.03 
57 1175 1908.75 18.35 0.708 -0.16 

       

Lap Held 5mm 
Spacing DPC OFF 

58 0025 1851.25 23.66 1.01 -0.07 
59 0600 1880 23.41 1.14 -0.11 
60 1175 1908.75 23.55 0.930 0.00 

       

Edge # 2 - Primary 
Portrait 

61 0025 1851.25 23.66 0.069 0.06 
62 0600 1880 23.41 0.083 -0.18 
63 1175 1908.75 23.55 0.076 0.11 


